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Introduction
The Global Mapper Mobile® Android application allows you 
to take your Global Mapper data into the field, work with it, 
edit it and share it back to the Global Mapper desktop 
application. The mobile app includes many of the basic 
data viewing and editing features found in Global Mapper 
desktop, as well as some features unique to the mobile 
app. 

Map data can be shared from the desktop by loading a 
Global Mapper Mobile Package (*.GMMP) generated from 
the Global Mapper desktop application. In this way many 
of the file formats, analysis and GIS Tools accessible 
through Global Mapper desktop can be viewed on the 
mobile device in the field. 

Vector features may  be collected manually or auto-
matically using the mobile app. Global Mapper Mobile® 
can create GPS track features, tag photos taken with your 
mobile device to features, and allow for manual creation of 
points, lines and polygons. Features may also be added 
using predefined feature templates exported from the 
desktop application, making remote data collection easy 
and consistent, which is critical when conducting field 
work. 

Global Mapper Mobile® can also connect to online 
sources, such as imagery, basemaps, terrain data and 
charts. Global Mapper Mobile® includes a list of built-in 
online data sources, and, with the Pro Module, can support 
custom added sources. With the addition of the Pro Mod-
ule, this online data can also be saved on the device, for 
later use in the field away from a network connection. 



Requirements
 l Android device such as tablet (highly recommended) 

or Android phone
 l Global Mapper Mobile® installed. Available from the 

Google Play Store.

Additional Recommendations
 l Host machine (Windows desktop, laptop, etc)
 l Licensed version of Global Mapper installed on that 

machine. We will refer to this as “Global Mapper 
desktop” in this document.

Enabling Location Services
The operating system will ask you to grant Global Mapper 
Mobile® permission to access location data the first time 
you enable this feature. Global Mapper Mobile uses loc-
ation data for live position display and the creation of vec-
tor features only. It is not transmitted or saved in any 
other way.

If Location Services are not currently enabled, you can 
enable them in the system settings, by going to Global 
Mapper Mobile application settings in the application list at 
the bottom of the main settings page. Global Mapper 
Mobile® will still work and open map data if location ser-
vices are disabled, but you will be unable to use tools that 
require GPS location. You will receive some GPS error mes-
sages, but you will still be able to use the other func-
tionality. 



Your mobile device uses a technology called Assisted GPS.  
When you first enable a tool that uses GPS, the device will 
use local WiFi hotspots or cell towers (if the device is 
equipped with a cellular option) to get an immediate estim-
ation of your location. If your device is equipped with GPS 
hardware (comes with the cellular option), it will then 
attempt to lock your position using actual global pos-
itioning satellites. This may take a few minutes. Thus, 
reported locations may be of low accuracy or may not work 
until a satellite lock is established. 

App Permissions
The Global Mapper Mobile Android application will request 
the following permissions:

 l Approximate Location (Network-based)
 l Precise Location (GPS and network based)
 l Modify or delete the contents of your SD card
 l Read the Contents of your SD card
 l Full Network Access

If location permissions are not given, the app will not be 
able to use the GPS mode to display current location, or 
create features from any of the GPS options. 

SD card access is not required, but is recommended for 
storage of Global Mapper Mobile Package files (*.GMMP).

Network access is used in the application to view the help 
files and other web links in the application info. It is also 
used when loading online data sources. 

To share from the device via email, the setup of the 
default mail application on the device is required. 



Technical Support
Technical support can be obtained on our website, by 
emailing support, or by sending an email through the 
mobile application. 

E-mail Support: mobilehelp@bluemarblegeo.com

To email an error log from the mobile application, tap the 
information button in the Main Menu, and choose the 
Email Error Log option. 

Please provide us with the following additional inform-
ation:

 l Type of data you are working with
 l Error messages encountered (if applicable)
 l Actions being Performed
 l Expected Outcomes

Global Mapper is user-data driven.  Each support issue is 
unique to that problem.  The information in the support 
request form is essential to solve each support request.

Website: http://www.blue-
marblegeo.com/support/index.php

What's New
Global Mapper Mobile version 2.1

New Features

 l Vector Feature Styling
 l Feature Types can be previewed in the Edit 

Feature window

mailto:mobilehelp@bluemarblegeo.com?subject=Global Mapper Moble Support
http://www.bluemarblegeo.com/support/index.php
http://www.bluemarblegeo.com/support/index.php


 l Terrain Layer Support
 l Hill shading
 l Terrain shader display as Atlas shader
 l View layer elevation at a specific location

 l Layer Transparency Settings
 l Improved color picker for color settings in Con-

figuration
 l Support for Dark Mode display

Pro Module New Features

 l Advanced GPS Support - Connect to external high 
accuracy Bluetooth GPS devices

 l Ability to view satellites, detailed location inform-
ation, and NMEA Stream

 l External GPS can be used for location based fea-
ture creation

 l Terrain shader selection/change within the app 
 l Water level display on terrain data

Global Mapper Mobile version 
2.0
New Features

 l Redesigned user interface for easier access to app fea-
tures

 l Streaming Online Data (Word Street Map, many more 
available with Pro Module)

 l Additional Projection Support
 l World Mercator
 l Web Mercator
 l Transverse Mercator
 l Lambert Conformal Conic



 l Custom Projection Support
 l Quick Picture Point
 l Create picture points from geotagged images saved to 

your device
 l Integrated cloud file sharing (iCloud, Dropbox, Google 

Drive and others)
 l Feature Labels retained in GMMP
 l Create new custom layers when creating features 
 l Feature index layer attributes
 l Measure Tool
 l Feature Search Tool
 l Coordinate format options
 l Task progress reporting with cancel
 l Diagnostics export options

Pro Module New Features

Global Mapper Mobile® now offers a paid Pro Module that 
unlocks additional features and functions in the app. 
Single user and enterprise licensing is available through 
the Blue Marble Geographics web page or by contacting 
our sales team at orders@bluemarblegeo.com.

 l Extensive selection of build-in online sources
 l Custom online data souces
 l Download streaming online sources for offline use
 l GeoPackage Import/Export
 l GeoPDF Import
 l GPS Averaging
 l Ability to select global projection and modify pro-

jection parameters in app
 l Add layers to existing map from file
 l Distance and Bearing from location to selected point 

displayed

 

https://www.bluemarblegeo.com/products/global-mapper-mobile.php
mailto:orders@bluemarblegeo.com


Pro Module
Global Mapper Mobile® offers a Pro Module for the applic-
ation that opens up additional feature and function of the 
app. 

Additional Features included with the Pro Module are: 

 l Additional Built-in Online Data Sources
 l Add Custom Online Sources
 l Save Online Imagery for Offline Use
 l GPS Averaging
 l Advanced GPS Options
 l Projection Options
 l Distance and Bearing from Point
 l Terrain Shader Options
 l Water Level Display
 l Add Layers from File
 l Import GeoPDF 
 l Import/Export GeoPackage

Purchase a Pro Module license from the Blue Marble Geo-
graphics web page, or by contacting our sales team at 
orders@bluemarblegeo.com.

Single and enterprise licenses are available through Blue 
Marble Geographics. Pro Module licenses are subscription 
based and should be renewed every year. 

The Purchase Pro Module option in Configuration leads to 
an in-app purchase of the Pro Module. For full license sup-
port or for enterprise licensing please contact our sales 
team at orders@bluemarblegeo.com to purchase your Pro 
Module license. 

https://www.bluemarblegeo.com/products/global-mapper-mobile.php
https://www.bluemarblegeo.com/products/global-mapper-mobile.php
mailto:orders@bluemarblegeo.com?subject=Purchase Pro for Global Mapper Mobile
mailto:orders@bluemarblegeo.com?subject=Global Mapper Mobile Pro Module


To register the Pro Module, choose Purchase Pro Module 
from Configuration. 

Register Pro 
The Pro Module for Global Mapper Mobile® requires a pur-
chased license. To Register the Pro Module the device 
must have an internet connection. Purchase a Pro Module 
license from the Blue Marble Geographics web page, or by 
contacting our sales team at orders@bluemarblegeo.com.

 1. Tap on Purchase Pro Module from Configuration and 
tap Register.

https://www.bluemarblegeo.com/products/global-mapper-mobile.php
mailto:orders@bluemarblegeo.com?subject=Purchase Pro for Global Mapper Mobile


 2. Tap Login and enter your  Blue Marble account log in 
information.

 3. Enter the full order number (XXXXXX-XXXXXXXX) 
received when you purchased the Pro Module and tap 
Confirm.



When the Pro Module is registered, tapping on the 
Purchase Pro Module option in Configuration will show the 
email, order number and expiration date of the Pro Module 
license.  

To unregister a device, select the option to Purchase Pro 
Module from Configuration and choose to unregister. If 
you are offline when you unregister you will not be able to 
register your license for the Pro Module on a new device 
until the previous one has connected to the internet and 
completed the unregistration. 
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Getting Started
The Start Page of Global Mapper Mobile provides quick access 
to start viewing and creating geospatial data. To get started 
mapping, open a map, or create a new map using the Online 
Sources option. To view a basic map of the world countries, 
load the default data. The default data may not be saved. 

To get back to the start page at any time, choose Unload All 
from the main menu. 

The Start Page provides access to the Main Menu, as well as 
the following quick buttons:

Open Map
This opens the Maps list. Select a map package from the list to 
open it. For more information see "Open Map File" on page 28

From the maps list, return to the start screen by choosing the 
back arrow on the top left. 

Online Sources
Load data from an online data source. The app provides a list of 
sources, or custom ones can be added. For more information 
see "Add Online Data Layer" on page 30.

Configuration
This provides access to all the global settings in the App. See " 
Configuration" on page 38
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Load Default Data
The 'Getting Started' map is installed with the application. You 
may use this map immediately to explore the features of Global 
Mapper Mobile®. 

The main screen contains several tools that provide quick 
access to the most commonly used functions. Many of these 
tools are very similar to Global Mapper desktop tools. 

Pan and Zoom
The image can be panned by dragging your finger along the 
screen.

The image can be zoomed in or out by using a pinch gesture. 
Placing two finger on screen and move them closer to zoom out. 
Move them apart to zoom in.
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 Control Center
This button is analogous to the Control Center button found in 
Global Mapper desktop. Tap to display a dialog listing the vari-
ous data layers currently loaded. Drag your finger to scroll the 
layers if needed. 

Visibility
Tap a layer name to toggle hiding or showing the layer. Hidden 
layers are indicated with a lighter color text and icon. 

Layer Options

Tap that appears after a layer name to bring up the Layer 
Options . You may hide layers, change the ordering of the lay-
ers, edit the layer name, and display the layer metadata. 

 Full Extent

Tap the  home button in the top right of the Control Center 
to zoom to the full data extent. 

 Additional Info
You may move the dialog by touching the title bar and drag-
ging. Tap the Close button at the bottom of the dialog, or tap 
the Overlay Control Center button again to close the dialog. 

The icon next to each layer indicates the type of data:
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  Vector
  Raster Imagery
  Elevation Grid

Layer Options

Press the button in the Control Center to display the layer 
options.

Move layers up or down in the drawing order using the move 
options. The layer at the top of the list will be the first layer 
drawn, and appear underneath subsequent layers on the map. 

 Choose the Zoom option to zoom to the extent of the current 
layer

Use the Move Up and Move Down arrows to move the cur-
rent layer in the drawing order.

 Use Move to Top to have the current layer be the first drawn 

layer, or Move to Bottom to make the current layer the last 
drawn layer. 

  Use the Hide option to  turn off the visibility of the current 
layer. Hidden layers will display in the Overlay Control Center 
with a lighter color text and icon. 

  Use the Remove option to remove the current layer form the 
map. 
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The Metadata for the layer is displayed when this option is 
tapped. Metadata includes information about the layer such as 
the geographic extent of the data, the count of features for vec-
tor layers, or the number of rows and columns for raster layers. 

The Description is the name of the layer that appears in the 
Control Center. Tap the description to edit. 

The Assign Index Attributes option will assign a numeric index 
attribute value to each feature.

The Renumber Index Attributes option will update the existing 
index attributes.

Vector

The Allow Feature Selection option can be turned off for vec-
tor features. These makes vectors in the layer not selectable. 

Assign Index Attributes will create a new attribute assigning 
a numeric index number to each 

Renumber Index Attributes will update the index attributes 
for a layer of features. 

Raster and Elevation

 The Translucency setting controls how the layer displays 
the layers beneath it. A lower translucency percentage will 
make the layer more see-through, while a higher percentage 
will make the layer more opaque. 
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 The Resampling Method determines how the color/elevation 
is displayed for each location based on the values in the file. 

 l None (Nearest Neighbor) - simply uses the value of the 
sample/pixel that a sample location is in. When resampling 
an image this can result in a stair-step effect, but will main-
tain exactly the original color values of the source image.

 l Bilinear Interpolation - determines the value of a new 
pixel based on a weighted average of the 4 pixels in the 
nearest 2 x 2 neighborhood of the pixel in the original 
image. The averaging has an anti-aliasing effect and there-
fore produces relatively smooth edges with less stair-step 
effect.

 l Bicubic Interpolation - a more sophisticated method that 
produces smoother edges than bilinear interpolation. Here, 
a new pixel is a bicubic function using 16 pixels in the 
nearest 4 x 4 neighborhood of the pixel in the original 
image. This is the method most commonly used by image 
editing software, printer drivers and many digital cameras 
for resampling images.

Note: Elevation shader and hillshading are controlled for 
all layers in the App Configuration "Shader" on page 41 
options. 
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Location Display
Touch this button to display your location on the map. The loc-

ation display icon will appear with an orange background  
when location is active. A blue dot on the map indicates your loc-
ation, and a blue arrow indicates your heading. A larger, trans-
lucent blue circle may also be visible, indicating the current GPS 
location accuracy. 

The Latitude and Longitude are displayed on the bottom of the 
screen. The location information will also report the elevation 
and accuracy. 

GPS - This will show only the blue dot icon showing the GPS loc-
ation.

Crosshair - This will show only the crosshair symbol in the cen-
ter of the screen. If elevation data is loaded and displayed, the 
layer elevation at the crosshair location will be displayed. 

GPS and Crosshair - This will show both the GPS location and 
show the crosshair symbol and location in the center of the 
screen. 

GPS Centered - This will center the blue dot icon showing the 
GPS location on the screen. As you move and the GPS location 
changes, the blue dot icon will remain centered on the screen 
as the loaded data pans behind it.

Drag the map and a crosshair symbol will be placed at the 
screen center. The Latitude and Longitude of the cross hair cen-
ter are displayed on the bottom of the screen. 
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Location Display option GPS and Crosshair enabled. 

The crosshair and coordinate display can be disabled in Con-
figuration, so that only the blue GPS location is displayed. Turn 
of Show Coordinate Info to disable the crosshairs and coordin-
ate information for the center of the map. If Always Show GPS 
Info is enabled, the GPS and crosshair locations will always be 
displayed when they are active. 
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 Main Menu
The Main Menu contains the following options.

Open Map File 28

Download 28

Folder 28

Options 28

Add Layer(s) From File 29

Add Online Data Layer 30

Save Online Imagery 30

Add Custom Sources 31

Save Map to File 33

Map File Format Options 33

Export Map to File 34

Unload Map 35

Advanced GPS 35

Connect to Device 36

Location 37

Satellites 37

NMEA Stream 37

38
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Configuration 38

Pro Module 39

Display 39

Shader 41

GPS Settings 42

Digitizer 44

Miscellaneous Settings 44

Information 45
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Open Map File
Tap this option to open the list of saved map packages. 

Select a map package from the list to open it. If there is already 
a map open, that map will be unloaded first, with a warning to 
save any changes that have been made to the loaded map. 

Tap the back arrow at the top of the list to go back to the pre-
vious screen. 

 Download
Tapping on the download icon in the bottom right of Maps 
screen will allow you to browse for *.GMMP files on your 
Android device and in file sharing apps.

 Folder 
This indicates the path to the current working directory. The list 
of available maps in the menu displays the Global Mapper 
Mobile Package files (*.GMMP) located in this folder. 

To navigate to a different location, use the up arrow next to 
the folder icon. 

Note: Save and Save As operations in the Export options 
will save the map package to the currently active directory. 

Options
For map package options press the vertical dots at the end of 
the package name. This provides a set of options for the 
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selected map. 

 l Tap the Info option to display map package information. 
This will display the file name, file size of the package, and 
the contained layers. 

 l Tap Copy to make a copy of the selected map. You will be 
prompted to name the copy and it will be saved to your 
mobile device. If the open map contains unsaved changes 
you will not have the option to make a copy.

 l Tap Rename to enter a new name for the selected map. 
You cannot rename a currently opened map.

 l Tap Delete to delete the currently selected map. It is not 
possible to delete the Getting Started map or the currently 
opened map.

 l Options export from this menu are Upload to File Loca-
tion or Email. If the open map contains unsaved changes, 
you will not have the options to upload or email the map. 
Before sharing the map, return to the Main Menu and select 
to Save Map to File. 

 

Add Layer(s) From File
  This tool requires a Pro license

This option from the main menu allows you to load layers from a 
file downloaded on the device.

Accepted file formats are:

 l Global Mapper Mobile Package file (*.GMMP)
 l GeoPDF 
 l GeoPackage



Global Mapper Mobile® Help by Blue Marble Geographics —30

Add Online Data Layer
Select the download online imagery option to connect to a 
streaming data source. 

 l Free Sources

OpenStreetMaps.org Global Street Maps

Additional built-in online sources are available with the Pro Mod-
ule. 

 l Custom Sources -   This feature requires a Pro license

This folder will appear when custom online sources have 

been added using the  button at the bottom of the 
source selection list. 

The added source requires an internet connection to load. 
To save a subset of the map tiles to the device for use off-

line, go to the  Main Menu and choose the Export option, 
then choose Save Online Imagery. 

 l Saved Sources -   This feature requires a Pro license

The saved sources folder appears when sources have been 
downloaded for use offline. To remove a downloaded online 
source, select it from the saved sources list, and then use 

the  at the bottom of the dialog. 

Save Online Imagery
  This tool requires a Pro license
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The Save Online Imagery option is available from the  
Main Menu, by going to  Export . This will download data from 
online sources open in the current map. 

If multiple online layers have been added to the current map, 
first select an online source to save in the Select a layer to Save 
dialog, and press OK to continue. 

Then select the number of map zoom levels to save. The map 
zoom levels are based on the current map display extent, and 
additional higher level data will be downloaded based on the 
number of zoom levels selected. Between 1 and 4 zoom levels 
may be saved. 

Name the saved online source. The source is location specific, 
so it is best practice to indicate both the source name and a loc-
ation description to identify the saved data. 

The saved source will not load automatically in the current map. 

To add the saved source to a map, select it by going to the 
Main Menu and choosing Online Sources, then finding the 
source in the Saved Sources folder. The saved source will be 
available to add to any map with or without network connection 
now that it has been saved to the device. 

Add Custom Sources
  This tool requires a Pro license

From the Add Online Data Layer screen, tap the button at the 
bottom of the screen to add a new custom online source. Select 
the source type you would like to add. The following source 
types are supported: 

 l ESRI RESTfil/Google Maps Tiles
 l OSM (OpenStreetMap Tiles)
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 l WMS (Web Map Service)
 l WMTS (Tiles WMS)

With a source selected tap the delete button to delete the 
source. Built-in sources cannot be deleted. 

ESRI RESTful/Google Maps Tiles and OSM (OpenStreetMap 
Tiles)

For these source types a the base URL must be entered. The 
base URL is the URL where the data for the tiled source can be 
found. 

Image File Type - Select the file type for the tile images, jpg or 
png

Max Zoom Level - Provide the maximum zoom level for the 
source

Tile Size - Specify the tile size in pixels 

Native Projection - Select the projection used for the tiles

Lat/Lon Bounding Box - Set the bounding box for the data spe-
cified in degrees latitude and longitude

Click OK at the top of the screen to add the new online source. 
The custom sources you create will be stored in a Custom 
Sources folder on the Online Sources List. 

WMS and WMTS

For WMS and WMTS source types, enter the Get Capabilities 
Server URL. After entering the Server URL, tap Get Layers at 
the bottom of the screen to query the server and list the avail-
able layers.
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Service Name - Specify the Service Name if different than WMS 
or WMTS

Projection - Specify the projection for a selected layer 

Image Format - Specify the image format for the selected layer

Click OK at the top of the screen to add the new online source. 
The custom sources you create will be stored in a Custom 
Sources folder on the Online Sources List. 

Save Map to File
This option allows saving map data to a Global Mapper Mobile 
Package file (*.GMMP)

Save Map stores changes to the current GMMP file on the 
device. 

Save Map As creates a new GMMP file. The new name will 
appear on the Maps list. 

Save Online Imagery -   This feature requires a Pro license - 
allows downloading the streaming online sources for use off-
line. 

Map File Format Options

Global Mapper Mobile Package file (*.GMMP)

Include Hidden Layers - All layers, visible or hidden, from the 
open map will be saved.

Double-Precision Vector Coordinates - Double precision 
format will be used to save vector data. This will increase accur-
acy in the coordinate values but increases the file size. 
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GeoPackage (*.gpkg)

This format requires a Pro Module license

Include Hidden Layers - All layers, visible or hidden, from the 
open map will be saved.

Table Name - Allows you to customize the table name

Max Zoom Level - Choose the maximum zoom level from a list 
(zoom levels 3 to 23)

Number of Zoom Levels -Enter the number of zoom levels

Tile Image Format - Choose to save tiles in JPG or PNG 
format. 

Tile Image Size - Select the tile size in pixels

JPG Quality - Enter the JPG quality (1 to 100)

Export Map to File
Tapping the Export Map to File option from the Main Menu will 
show two options for exporting the currently loaded map

 l Upload to File Location - With this option you can upload 
the map to any file sharing service or shared drive you 
have set up on the device. 

 l Email - The email of data from Global Mapper Mobile 
requires setup of the default mail application on the device. 

Note: If the current map contains changes that are not 
saved, you will be asked to save the map, using the Save 
Map To File menu option, before exporting. 
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Unload Map
The unload all option closes the open map and returns to the 
start screen. 

There will be a prompt to save the current map if new vector fea-
tures have been added to the map that are not saved. Note the 
adding of online sources does prompt to save the map before 

closing, but can be saved by manually saving from the  Main 
Menu Export options.  

Advanced GPS
  This tool requires a Pro license

The Advanced GPS options allows you to view detailed location 
information and manage a NMEA stream from a connected 
external GPS device. This location information will also be used 
for GPS based digitizing.

Setting up a New Device

An external GPS unit used with Global Mapper will replace the 
internal location services information on your device with the 
NMEA stream from the external GPS unit.

Using a bluetooth connected external GPS device with Global 
Mapper Mobile® requires a companion app for the GPS device 
to be installed on your mobile device. The appropriate com-
panion app is most likely produced by the GPS unit's vendor, 
refer to the device's manual to determine the specific app to 
download. 

In order to use an external GPS device in Global Mapper Mobile 
on Android, the device must be set to Developer Mode with 
Allow Mock Locations enabled. This allows the external GPS to 
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take over the location service and be visible to Global Mapper 
Mobile.

Follow these steps the make the GPS device location accessible 
to the Global Mapper Mobile app.

 1. Enable Mock Locations for your Android Device in Settings 
> Developer Options > Allow Mock Locations. The location 
of this setting may vary for your particular mobile device. 

Note: Some devices may first require you enable 
developer mode by going to Settings > About and tap-
ping the Version several times. Refer to your device's 
manual for details.

 2. Ensure the GPS device is on an in bluetooth pairing mode. 
 3. On your Andriod device, Settings > Bluetooth and find your 

device listed under Available Devices. 
 4. Download the companion app appropriate for your GPS 

device. Refer to the device's manual to determine the spe-
cific app to download. Once installed, use the app to con-
nect to the device prior to opening Global Mapper Mobile®.

Connect to Device
Open the GPS companion app and confirm your GPS device is 
connected prior to opening Global Mapper Mobile®. 

Note: Some Android devices require the GPS companion 
app to be closed to stream and record data. Please refer to 
the GPS device manual and companion app for the settings 
specific to your GPS setup.

From the Main Menu in Global Mapper Mobile®, tap Advanced 
GPS > Connect to Device.
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Location
View advanced location information gathered from the external 
GPS.

Satellites
View the satellites being used by the external GPS to determine 
location. 

The satellite map will display satellites within range based on 
their location, with those to the north at the top of the screen. 
Those closer to the center of the map have a higher altitude on 
the horizon. Satellites not being used for location (that have a 
low signal to noise ratio) will appear as hollow circles.

Below the satellite map expand the section to see the signal to 
noise ratio for each satellite in range, represented as a bar and 
a number. Each list shows a count of how many satellites are in 
range for that constellation.

NMEA Stream
Shows the NMEA Stream as it comes from the external GPS. On 
this screen you can Record the NMEA stream to a text file, 
Pause the data stream, and Clear the data stream shown.

Tapping to Record in the bottom right of the NMEA Stream 
screen will begin recording the data. Upon selecting this option 
the Record option will change to Stop Recording. Tapping to 
Stop Recording will prompt you to Save NMEA Log. 
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From the Save NMEA Log options, select to either Email, Upload 
to File Location, or Save to Map Folder. 

 l Email  - This option requires configuration of the default 
mail application on the device in order to generate the 
email. The NMEA Stream text file will be attached to the 
generated email.

 l Upload to a File Location - This option will save the 
NMEA Stream text file to a selected file location. The loc-
ations available will be the file sharing methods you have 
set up on the device. 

 l Copy to Map Folder - This option will save the 
NMEA Stream text file to the folder location of the open 
Global Mapper Mobile Package file (*.GMMP) map file. 

 Configuration
Taping this button will display a menu that allows you to set 
global application settings. 
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Pro Module 39

Display 39

Shader 41

GPS Settings 42

Digitizer 44

Miscellaneous Settings 44

Pro Module
Purchase Pro Module - Register the Pro Module with an order 
number from Blue Marble Geographics. If the Pro Module is 
registered this will show the user, order and expiration data of 
this registration. 

Display
Background Color - Select this to show the background color 
picker dialog. Select the background color with the color picker 
and tap OK to apply the color. 

Map Orientation - Specify the orientation of the map. Choose 
from the following options: 

 l Rotate North Up - This is the default settings. When the 
device is rotated, the orientation of the application will 
switch between landscape and portrait orientation. 

 l Fixed Landscape - Select this option to lock the applic-
ation to the horizontal/ landscape orientation. 

 l Fixed Portrait - Select this option to lock the application to 
the vertical/ portrait orientation. 

Show File Name - When enabled the project name will be dis-
played at the top of the map. 
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Show Coordinate Info - When enabled the Position Display 
will show coordinate values in Latitude, Longitude at the bottom 
of the map for the current GPS location, or the center of the 
map view inside the crosshairs. 

Coordinate Info Location - Specify where the coordinate info 
is displayed. 

Coordinate Format - Specify the format of the displayed 
coordinate info. For each type listed below there is a lower and 
higher precision option.

 l Decimal Degrees (Example: 44.29384° N, 69.80408° W)
 l Degrees Minutes Seconds (Example: 44° 17' 37.824" N, 

69° 48' 14.688" W)

Linear Units - Use this option to set the linear unit display to 
either meters or feet. 

Show Scale - This option will display a scale bar on the map. 
This is turned on by default. 

Scale Location - Specify the location where the scale info is 
shown. 

Show Shortcut Bar - This option will display a vertical short-
cut bar along the left size of the screen. 

Shortcut Items - Customize the options shown in the shortcut 
bar when enabled. 

 l Advanced GPS -   This tool requires a Pro license - Enables 
bluetooth, location, satellites, and NMEA stream 

options for quick access to the Advanced GPS options
 l Pan - Enables four direction arrows  to pan
 l Zoom - Enables zoom in and zoom out icons 
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Crosshair Color - Select this to show the  color picker dialog to 
change the color of the crosshairs displayed on the map when 
position display is enabled. The default color is gray. 

Show Feature Labels - When enabled labels for vector fea-
tures will be displayed. 

Shader
Shader Name -   This feature requires a Pro license - Select 
the sader used to display loaded elevation data. 

Available Shaders

 l The Atlas Shader is the default shader. Like many other 
shader options the color ramp will scale to the data range. 

 l The Color Ramp Shader displays a ramp from blue for the 
low elevations to red for the highest elevations.

 l The Daylight Shader colors all elevations the same and is 
only useful when hill shading is enabled.

 l The Global Shader uses fixed elevation values so elev-
ations will be colored the same from map to map. This 
shader is designed for datasets covering large areas. 

 l The Gradient Shader uses a gray scale to color the elev-
ation with lower elevation values colored darker than higher 
values. 

 l The HSV Shader maps the elevations onto the HSV (hue 
saturation value) color space.

 l The NDVI Shader (Normalized Difference Vegetation 
Index) is used for layers with the NDVI calculation applied. 

 l The NDWI Shader (Normalized Difference Water Index) is 
used for layers with the NDWI calculation applied. 

 l The Slope Shader displays loaded elevation data by slope 
rather than elevation using a gray scale shader. This 
shader allows you to identify areas that are flat versus 
those that are steep. 
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 l The Slope Direction Shader colors loaded elevation data 
by the direction in which the terrain faces. This shader uses 
green for north, blue for east, red for south, and white for 
west. 

Enable Hill Shading - Enable hill shading to show loaded elev-
ation data shaded with relief. With this option off elevation data 
appears flat with elevations shown only with the set shader. 

Display Water Level - Enable to display water on loaded elev-
ation layers. 

Water Level -   This feature requires a Pro license - Set the 
water surface level in meters for the water level display.

GPS Settings
Enable GPS As Needed - To obtain the highest accuracy, 
GPS services are always in use by default. Enable this option to 
only turn on GPS when needed, which will help preserve battery 
life. 

GPS services can take time to obtain accuracy when first 
enabled, so if this setting is enabled, then we recommend 
waiting to obtain accuracy before digitizing new features. 
For more information see "Enabling Location Services" on 
page 9

Best Accuracy - This is enabled by default. The device will 
return the most accurate location data the hardware is capable 
of. This will be on the order of 10 m with an internal GPS unit.

When disabled, the device will not work the hardware as hard, 
prolonging battery life. (This may disable GPS and use only Wi-
Fi location services.) However the accuracy will be on the order 
of 100 m.
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We recommend enabling best accuracy when using GPS 
related functions, such as displaying the current location 
and creating features using location data. Disable Best 
Accuracy if you are not using higher accuracy GPS related 
functions and battery life is an issue.

Show Accuracy - When enabled, a light blue circle will be 
drawn around the GPS position display symbol, indicating the 
accuracy range. 

Always Show GPS Info - When enabled coordinates and 
accuracy of the GPS location will be shown regardless of display 
settings. 

Show Distance and Bearing -   This feature requires a Pro 
license - When enabled the distance and bearing from the 
GPS location to the selected point feature will be shown below 
the GPS Info. 

Record Distance Interval - The distance interval is used with 
the GPS Auto Distance option for creating Points, Lines or 
Areas. 

Record Time Interval - The time interval is used with the GPS 
Auto Time option for creating Points, Lines or Areas. The time 
interval is set in seconds. 

Default Point/Line/Area Types - Use these options to set 
the default feature type and style for features created using a 
GPS mode.

Added Vertex Sound - Specify the sound to use when adding 
points. Note the sound will not play if the device is set to silent. 
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GPS Average Min Horz Accuracy - Specify the minimum hori-
zontal accuracy of point to be included in GPS average cal-
culation.

GPS Average Show Data Points - When enabled all points 
used to calculate average will be displayed.

Digitizer
Add Index Attribute – This option will add a numeric index 
attribute to digitized features

Copy Attached Photos to Library – This option saves pic-
tures taken within the application attached to a vector feature  to 
the device photo library. When this option is enabled it will be 
indicated  by a check mark at the end of the setting. 

If this setting is not enabled, a temporary copy of the picture 
will be created, and attached when the map data is saved to a 
*.GMMP file. The temporary image will be deleted when the cur-
rent map data is unloaded.

Notation Editor Auto Capitalize – When enabled, this set-
ting will automatically capitalize letters at the start of a line or 
beginning of a sentence. 

Notation Editor Auto Correct – When enabled, this setting 
will automatically correct the spelling of typed words using the 
built in auto correction tool. I will also highlight unrecognized 
words with a red underline, and show possible recognized 
replacements when clicked. 

Miscellaneous Settings
Projection -   This feature requires a Pro license - With the Pro 
Module licensed the projection for a map can be changed. 
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Supported projections in Global Mapper Mobile® are: 

 l Geographic (Latitude/Longitude)
 l Lambert Conformal Conic
 l Mercator
 l Transverse Mercator

Keep Application Awake - When enabled the device will not 
go to sleep while the Global Mapper Mobile application is open 
and displayed on the device. This uses more battery power. 

Error Log Detail Level - Set the level of detail recorded in the 
error log on a scale 0 to 4. A higher number will record a higher 
level of detail. 

Restore defaults - Select this option to return all settings to 
the default values. 

 Information
About Global Mapper Mobile - Select to show the Global Map-
per Mobile About dialog. This will indicate the application ver-
sion and provide links to sales and support.

Quick Start - The quick start guide is available when first open-
ing the app. This is a short introduction to the app, available off-
line. 

Online Help - Select to show the Global Mapper Mobile® help 
documentation. To view on the web navigate to http://blue-
marblegeo.com/knowledgebase/global-mapper-mobile-
android-beta/

Global Mapper Forum - Select to show the Global Mapper 
forum website. The Global Mapper User Forum is an inde-
pendent forum for users of Global Mapper to provide support to 
each other. While Blue Marble Geographics is active on the 
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forum, it is intended for peer-to-peer support. To reach the 
application support team email geohelp@bluemarblegeo.com 
or submit a request via our website: http://www.blue-
marblegeo.com/support/support.php

Diagnostics - Select this option to view the error log or send 
diagnostic information to the Blue Marble Geographics applic-
ation support team. The error log detail can be set in App Con-
figuration. Usage and error tracking needs to have been 
enabled previously for the error log to exist.

 l Email Diagnostics - This option requires configuration of 
the default mail application on the device in order to gen-
erate the email. The error log will be emailed to our applic-
ation support team. Please include any additional 
information about the error you are receiving when sending 
the error log. 

 l Upload Diagnostics to a File Location - This option will 
save the error log as a file that you can then share through 
file sharing methods you have set up on the device. 

 l Copy Diagnostics to Map Folder - This option will export 
a copy of the error log to the location of the open Global 
Mapper Mobile Package file (*.GMMP) map file. 

 l View Error Log - This option will open the Global Mapper 
Mobile® error log for viewing in the app. 

View License Agreement - View the app software license 
agreement. 

View Privacy Policy - View the Blue Marble Geographics pri-
vacy policy. 

mailto:geohelp@bluemarblegeo.com?subject=Global Mapper Mobile Support
http://www.bluemarblegeo.com/support/support.php
http://www.bluemarblegeo.com/support/support.php
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Tools
The Tools Menu can be found in the bottom left corner of the 
screen. The tool that is selected will be shown in this corner. 
Tapping on the current tool will open the Tools Menu that will 
allow you to choose from the Global Mapper Mobile® tools. 

Digitizer 47

Measure 56

GPS Average 56

Search 57

Digitizer
The Digitizer tool can create new features and edit existing fea-
tures. 

Create Points 48

Create Lines 49

Create Areas 50

Feature Editing and Properties 52

Working with Feature Templates 55
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 Create Points
The point creation tool is used to create new point features. This 
button is available in the bottom bar of the opened map. 

Point features can be created by tapping the map, using the 
internal GPS, or auto-collecting with GPS location using distance 
or time. 

Manual Tap

This creates new points where the screen is tapped. The New 
Feature dialog will appear to allow editing the attributes. 

GPS Tap

Tap anywhere on the screen to place a feature vertex at the cur-
rent GPS location.

GPS Auto Distance

This option will automatically create new points using the GPS 
location. A new point will be created once the specified distance 
interval is reached from the last placed point. The distance inter-
val is set in the configuration.  Use the check button or click the 
create point icon again to stop collecting point features. Select 

features with the Feature Edit tool  to edit the attributes. 

GPS Auto Time

This option will automatically record vertex points at a fixed 
time interval.  The time interval is set in the configuration. Use 
the Confirm button or click the create point icon again to stop 
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collecting point features. Select features with the Feature Edit 
tool to edit the attributes. 

Pictures

This options will allow you to choose a picture taken on your 
device and place a picture point according to the EXIF inform-
ation from the image. Global Mapper Mobile® will search for pic-
tures on your device that were taken within the current screen 
bounds of the displayed map. To add a picture point with this 
method, you must allow Global Mapper Mobile® to access the 
pictures on your device. 

To take a picture and add directly add it to the map, tap and 
hold on the map. This will open the device camera and allow 
you to take a picture that will then be added to the map as a pic-
ture point at the GPS location. This action can be taken when 
any tool is selected in Global Mapper Mobile®.

 Create Lines
The line creation tool is used to create new line features. This 
button is available in the bottom bar of the opened map. 

Manual Tap

This creates feature vertices where the screen is tapped. 

Double tap or click the Confirm button   to complete the fea-
ture and begin editing the attributes. 
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GPS Tap

Tap anywhere on the screen to place a feature vertex at the cur-
rent GPS location. The distance interval is set in the con-

figuration. Use the Undo button  to remove a vertex, and the 

Confirm button  to complete the feature and begin editing the 
attributes. 

GPS Auto Distance

This option will automatically create features using the GPS loc-
ation. The time interval is set in the configuration. A feature ver-
tex will be created once the specified distance interval is 

reached from the last placed vertex.  Use the Undo button  to 

remove a vertex, and the Confirm buttonto complete the fea-
ture and begin editing the attributes. 

GPS Auto Time

This option will automatically record vertex points at a fixed 

time interval.  Use the Undo button  to remove a vertex, and 

the Confirm button  to complete the feature and begin editing 
the attributes. 

 Create Areas
The area creation tool is used to create new areas features. This 
button is available in the bottom bar of the opened map. 
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Manual Tap

This creates feature vertices where the screen is tapped. 

Double tap or click the Confirm button   to complete the fea-
ture and begin editing the attributes. 

GPS Tap

Tap anywhere on the screen to place a feature vertex at the cur-
rent GPS location. The distance interval is set in the con-

figuration. Use the Undo button  to remove a vertex, and the 

Confirm button  to complete the feature and begin editing the 
attributes. 

GPS Auto Distance

This option will automatically create features using the GPS loc-
ation. The time interval is set in the configuration. A feature ver-
tex will be created once the specified distance interval is 

reached from the last placed vertex.  Use the Undo button  to 

remove a vertex, and the Confirm buttonto complete the fea-
ture and begin editing the attributes. 

GPS Auto Time

This option will automatically record vertex points at a fixed 

time interval.  Use the Undo button  to remove a vertex, and 

the Confirm button  to complete the feature and begin editing 
the attributes. 



Global Mapper Mobile® Help by Blue Marble Geographics —52

Feature Editing and Properties

Touch the digitizer pencil button to enable/ disable the 
Feature Edit tool. The button will be tinted orange when 
enabled. 

This tool enables editing of selected features. Tap a feature to 
select it, tap the feature again to edit it. The Edit Feature dialog 
will appear. As with the Global Mapper desktop, the feature will 
be highlighted on the map. 

Edit Feature

This menu displays properties of the currently selected feature 
and provides options to edit the feature. The same options will 
be see on the New Feature screen when creating new features. 

Layer

Displays the name of the layer the selected feature is asso-
ciated with. 

Type

Displays the point, line, or area feature type. Tap to display the 
Feature Type menu to change. Feature Types will change the  
visual styles of a feature. 

Name

Displays the name/ label of the feature. Tap to edit. 

Description

Displays the description of the feature. Tap to edit.
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Vertices

Tap to display the vertex locations of the current feature. Ver-
tex values in Global Mapper Mobile Package file (*.GMMP) and 
newly created features are stored in Latitude, Longitude in 
WGS84. Select a vertex to enable adding after, editing, or delet-
ing. 

Vertex Editing

 Add Vertices

Tap this button to open a dialog for entering latitude and lon-
gitude coordinates. If an existing vertex is selected, the new 
vertex will be inserted after it. Otherwise the vertex will be add 
at the end. 

Edit Vertex

Tap a vertex and then tap this button to edit the Latitude and 
Longitude values of the vertex. 

Delete

Tap a vertex and then tap this button to delete the selected ver-
tex. 

Attributes

Lists the feature attributes. Touch any attribute to edit. The 
Feature Attribute dialog will be shown.  Specify a new name or 
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value or delete the attribute.

Edit Attributes

Notation

Feature Notations are special attributes designed for storing 
longer descriptions. Feature Notation will display with line 
breaks and Tap the notation option to add, view or modify the 
feature notation. The notation will also appear in the attribute 
list once added. 

Attach New Photo

Camera- attach new image from camera

Tap this option to display the default camera control. Take a 
photograph and select “Use Photo”. The photo will be placed in 
your library and a copy will be embedded in an exported pack-
age file. The photo will automatically be geotagged if the GPS 
Tool is enabled during the attach operation. For settings see 
Files Settings.



Global Mapper Mobile® Help by Blue Marble Geographics —55

Gallery - attach existing image from gal-
lery

Tap this option to display the photo gallery.  Choose an image to 
attach to the selected feature. A copy of the photo will be 
embedded in an exported package file. The photo will auto-
matically be geotagged if the GPS Tool is enabled during the 
attach operation.

Add Attribute

Tap to create a new attribute. The Feature Attribute dialog, 
shown below, will be displayed allowing you to specify the attrib-
ute name and value.

Working with Feature Templates
If a layer has been defined in the Global Mapper Mobile package 
file to use a feature template, it may include required attrib-
utes, and/or lists of possible attribute values. 

When adding a feature to a layer with a feature template, you 
must conform to the template settings. Attributes with a 
defined list of possible values will show a pick list of possible val-
ues when edited, rather than the standard edit attribute dialog. 
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Tap the desired value in the list to update the attribute. The cur-
rent value will appear with a check mark. 

After clicking OK to complete the feature, you will be prompted 
to confirm any required attribute values for the feature. 

Measure
Selecting the Measure tool will show a crosshair symbol in the 
center of the screen and the coordinates of the crosshiar will be 
show on the screen. 

Tap anywhere on the map to place a yellow measure point in 
the center of the crosshair. Pan and zoom to move the crosshiar 
to a different location on the map and tap anywhere to add 
another measure point. The Segment Length and Total Length 
of the line being drawn with the measure tool will be shown 
below the coordinate location of the crosshair. 

Use the Undo button to delete the last measure point. Use 

the Confirm button to complete the measurement. 

Switching to a different tool or starting a new measurement will 
clear the current measurement. 

GPS Average
  This tool requires a Pro license

When in use the GPS Average tool collects positional inform-
ation constantly and when stopped will average that inform-
ation for increased GPS accuracy. 
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With the GPS Average tool selected, tap the play button to 

start collecting positional data. Tap the stop button to stop 

the data collection, and the undo button to clear collected 
data and reset the tool. 

The GPS Averaging tool will show the current GPS location info 
as well as the running average, accuracy, elapsed time, and 
number of points collected.

When using the GPS averaging tool, tap the create a point 
feature button to digitize a point at the location determined by 
the GPS Average.

Search
Select Search to search loaded vector features by an attribute. 

Tap the Search button to launch the search. 

At the bottom of the search screen, tap Points, Lines and/or 
Areas to select the type(s) of features you would like to search. 
Select multiple features types here to search multiple types. 

Tap an attribute name from the top section of the screen to 
begin defining your search. With an attribute name selected 
from the top portion of the screen, select attribute values from 
the bottom section of the screen to search for and select all fea-
tures with the selected values for the given attribute. 
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Tap OK to complete the search and return to the map view. 
Features that meet the search conditions will be selected. Click-

ing the Delete button will delete the selected features. 
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Loading Data
Data for Global Mapper Mobile® can be prepared in Global Map-
per desktop, then exported to a Global Mapper Mobile Package 
file (*.GMMP). 

Users with the Pro Module for Global Mapper Mobile® can also 
import GeoPDF and GeoPackage files. 

 1. Prepare data for export in Global Mapper desktop.
 2. Select File > Export > Export Global Mapper Mobile® File…
 3. Specify the desired export options. The format is a variant 

of the Global Mapper Package (*.GMP) file format, and 
many of the export options are similar.

 4. Click “OK” and specify file name (*.GMMP).

 

There are multiple methods for transferring data from a com-
puter to the Android device, including connecting the device to 
the computer and using file browser, emailing the file, and 
other file sharing apps that allow loading files on the Android 
device. See more information below about these methods and 
other recommendations and data options.

Data Recommendations 60

60

Adding Data to an Android Device with Finder 60

Adding Data via Email 61

Adding Data with other File Sharing Apps 62

Feature Templates 62
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Data Recommendations
Mobile devices are typically not as powerful as the desktop or 
laptop machine you probably run Global Mapper desktop on. In 
particular, run-time memory available to applications is quite 
limited. The operating system will shut the application down if it 
consumes too much memory. 

It is recommended that you simplify data to be used in your 
mobile app as much as practical. This means possibly reducing 
the resolution of raster and grid layers. Large Lidar data sets 
are simply not practical and it is recommended that you grid 
any large data for use in the mobile device. The app does not 
currently support Lidar data. 

Adding Data to an Android 
Device with Finder
 1. Connect the mobile device to a computer using a USB sync 

cable.

 2. Use the file browser and navigate to the location on your 
machine where you have stored your *.GMMP file. Copy 
this file. 

 3. Use the file browser to navigate to the folder on the Android 
device where you would like to copy your *.GMMP file and 
paste the copied file to that location.

NOTE:The 'GlobalMapperMobile' directory (shown below) 
was manually created on the device. 

 4. To access data in a specific directory within the application 
navigate to:



Global Mapper Mobile® Help by Blue Marble Geographics —61

 l Configuration > Files: Package Directory and set the 
intended directory

 l This directory will remain the active directory until 
changed. Any *.GMMP files added to that directory will 
be available within Global Mapper Mobile®

Adding Data via Email
Data can be loaded into Global Mapper Mobile® by emailing a 
Global Mapper Mobile Package file (*.GMMP) as an attachment. 
Load the email in a Mail application, and tap on the attachment. 
You will then need to save the *.GMMP to a specific directory on 
your device or tap the *.GMMP file to download it and launch 
Global Mapper Mobile®.

When you launch Global Mapper Mobile, the *.GMMP will be vis-
ible if it was saved to the active directory. Refer to Step 4 of 
Adding Data to Android Device with File Browser to change/set 
the active directory within the application.  
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Adding Data with other File Shar-
ing Apps
A Global Mapper Mobile Package file (*.GMMP) can also be 
shared via common file sharing apps such as Dropbox or 
Google Drive. Open or select the *.GMMP file inside of the file 
sharing application, then chooseto save it to a specific directory 
on your device or select the Open With... option launch Global 
Mapper Mobile® and open the Map Package. 

When you launch Global Mapper Mobile, the *.GMMP will be vis-
ible if it was saved to the active directory. Refer to Step 4 in 
Adding Data to Android Device with File Browser to change/set 
the active directory within the application.

Feature Templates
Features may be created according to a pre-defined template. 
Applying a template will automatically assign various feature 
properties and attributes to a new feature. An example of an 
application of feature templates is using Global Mapper Mobile 
to take an inventory of various assets in the field. A feature can 
be created at the asset location, using the GPS functionality, 
and desired information about the asset can be entered into pre-
configured attributes.

Feature templates are defined in Global Mapper desktop. Click 
on the Configuration button, and select the “Feature Tem-
plates” tab to create and edit templates.
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Like custom feature types, the feature template descriptions 
are saved in the user’s data folder (see Help | About). Feature 
template definitions can be imported/exported for backup or 
sharing with other users. (When you import a package file con-
taining feature template layers, described shortly, the tem-
plates described in that file will be added to the user’s template 
collection.)

Feature templates are defined with the following dialog:
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Attributes are defined using the Feature Template Attribute dia-
log:
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Attribute values may be “free form”, allowing the user to enter 
any string value, or enumerated allowed values. Allowed values 
are attached to the attribute by clicking the “Allowed Values…” 
button. You may allow users to edit attributes, or define them 
as constant with the “Value editable” checkbox. If the “Value 
input required” check box is checked, the user will be prompted 
to enter a value for the attribute when a new feature is created. 
(The user may add additional attributes to a feature if desired.)
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Once the desired feature templates have been defined, layers 
that can apply the templates must be added to your project. 
From the "Feature Templates" dialog in Configuration, select 
the template and choose to "Create Empty Template Layer..." 
from the bottom of the dialog. Another method to add an empty 
template layer to a project is to click on the Overlay Control 
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Center button, and right click on the layer list area. Select the 
menu option “Create a feature template layer…”. A new layer 
will be created and a layer property sheet will be displayed. 
Select the “Template” tab to specify which feature template 
that layer will apply to new points added to that layer. 

Once the feature template layers have been defined, the pro-
ject is exported to a Global Mapper Mobile Package file 
(*.gmmp).

Users of Global Mapper desktop may also create features in a 
template layer. To do so, use the Digitizer to create a new fea-
ture. Select the feature template layer to place the new feature. 
(Only those template layers with compatible template types, 
point, line, or area, will be included in the layer list.) 

The user may only add features of the type defined by the feature 
template to the layer.
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If there are any attributes with the “Value input required” 
option set, the user will be prompted for those values after click-
ing OK.

A similar procedure is conducted to create features using the 
mobile application.
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Exporting Data
The main methods for getting saved data off of the mobile 
device are via email, uploading to a file location, , or trans-
ferring files to a connected computer with file browser.

Export the currently open map with the Export Map File option 
from the Main Menu, or to export a map from the Maps list, tap 

the Map Options. With either method you will see the fol-
lowing two options for export:

 l Upload to File Location - With this option you can upload 
the map to any file sharing service or shared drive you 
have set up on the device. 

 l Email - The email of data from Global Mapper Mobile 
requires setup of the default mail application on the device. 

 

Exporting Data with Finder
The procedure is similar to loading data to the Android device. 

With the Android device plugged into your computer, use File 
Explorer to navigate to the directory on the device where the 
*.GMMP is stored. This file can then be copied to a location on 
your computer.
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Additional Resources
Webinars

Online Help
Online Help Global Mapper Mobile ios

Online Help Global Mapper Mobile android

http://bluemarblegeo.com/knowledgebase/global-mapper-mobile-ios/
http://bluemarblegeo.com/knowledgebase/global-mapper-mobile-android-beta/

	Global Mapper Mobile Help-Android
	Introduction
	Requirements
	Additional Recommendations

	Enabling Location Services
	App Permissions
	Technical Support
	What's New
	Global Mapper Mobile version 2.1
	New Features
	Pro Module New Features
	New Features
	Pro Module New Features



	Pro Module
	Register Pro

	Getting Started
	Open Map
	Online Sources
	Configuration
	Load Default Data
	Pan and Zoom

	Control Center
	Visibility
	Layer Options
	Full Extent
	Additional Info
	Layer Options
	Vector
	Raster and Elevation


	Location Display
	Main Menu
	Open Map File
	Download
	Folder
	Options

	Add Layer(s) From File
	Add Online Data Layer
	Save Online Imagery
	Add Custom Sources
	ESRI RESTful/Google Maps Tiles and OSM (OpenStreetMap Tiles)
	WMS and WMTS


	Save Map to File
	Map File Format Options
	Global Mapper Mobile Package file (*.GMMP)
	GeoPackage (*.gpkg)


	Export Map to File
	Unload Map
	Advanced GPS
	Connect to Device
	Location
	Satellites
	NMEA Stream

	Configuration
	Pro Module
	Display
	Shader
	GPS Settings
	Digitizer
	Miscellaneous Settings

	Information

	Tools
	Digitizer
	Create Points
	Manual Tap
	GPS Tap
	GPS Auto Distance
	GPS Auto Time
	Pictures

	Create Lines
	Manual Tap
	GPS Tap
	GPS Auto Distance
	GPS Auto Time

	Create Areas
	Manual Tap
	GPS Tap
	GPS Auto Distance
	GPS Auto Time

	Feature Editing and Properties
	Edit Feature
	Layer
	Type
	Name
	Description
	Vertices

	Add Vertices
	Edit Vertex
	Delete
	Attributes
	Edit Attributes
	Notation
	Attach New Photo


	Camera- attach new image from camera
	Gallery - attach existing image from gallery
	Add Attribute


	Working with Feature Templates

	Measure
	GPS Average
	Search

	Loading Data
	Data Recommendations
	Adding Data to an Android Device with Finder
	Adding Data via Email
	Adding Data with other File Sharing Apps
	Feature Templates

	Exporting Data
	Exporting Data with Finder

	Additional Resources
	Webinars
	Online Help


